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Heroic	is	a	child	version	of	Quality	WordPress	Theme.	Heroic	is	a	theme	for	corporate,	business’s,	fashion,	beauty,	firms,	companies	etc.	The	design	is	retina	ready	having	customize	front	page	in	which	you	can	add	a	banner,	your	feature	services	and	footer	credit	link.	Key	Features	Homepage	Template	Full	Width	Page	Template	4	to	5	level	Comment
Nesting	Social	Icons	Translation	Ready	Post	Thumbnails	Custom	Widgets	Copyright	Info	Editor	Custom	Logo	For	the	themes	language	translation	we	have	added	the	.po	file	so	that	you	can	translate	this	theme	in	whichever	language	you	want….	Below	Find	some	screenshots	Checkout	Heroic	Version	Checkout	Quality	Pro	Version	related	to	Heroic
100%	Money	Back	Guarantee	Your	purchase	is	covered	by	our	no-risk,	14	day	money	back	guarantee.	If	you're	not	completely	satisfied	with	the	product,	you	can	request	a	full	refund	up	to	14	days	from	original	purchase.	Trusted	by	the	biggest	brands	and	31,010	customers	WordPress	users	Who	should	use	HeroThemes	Plugins?	HeroThemes	plugins
are	perfect	for	freelancers,	agencies,	business	owners	small	or	big.	If	you	want	to	effectively	support	your	customers,	you	need	to	use	HeroThemes.	Our	mission	is	to	empower	businesses	to	offer	superior	support.	Do	HeroThemes	plugins	work	on	non-WordPress	sites?	No.	Heroic	KB	and	Heroic	Inbox	are	WordPress	plugins,	so	it	will	NOT	work	on
sites	that	do	not	use	WordPress.	Additionally,	HeroThemes	plugins	are	only	compatible	with	WordPress.com	when	the	account	level	is	Business	or	eCommerce.	You	must	be	using	a	self-hosted	version	of	WordPress	to	utilize	HeroThemes	plugins.	Will	HeroThemes	plugins	slow	down	my	site?	Our	plugins	are	carefully	built	with	performance	in	mind.	We
have	developed	everything	with	best	practices	and	modern	standards	to	ensure	things	run	smooth	and	fast.	Do	you	offer	a	free	trial?	We	don't	provide	trial	software,	instead	we	invite	you	to	view	the	demo	and	try	the	product	risk	free	with	our	14	day	money	back	guarantee.	What	payment	methods	do	you	accept?	We	accept	a	variety	of	credit	and
debit	cards	via	our	secure	payment	processors	Stripe	&	PayPal.	The	payment	methods	accepted	include	PayPal,	VISA,	Mastercard,	American	Express	and	Discover	Network.	Payment	details	are	encrypted	and	secure.	No	card	details	are	stored	on	our	server.	Heroic	is	a	responsive,	multi-purpose	WordPress	theme.	It’s	flexible	and	suitable	for
agencies,	blogs,	businesses,	finance,	accounting,	consulting,	corporations,	or	portfolios.	Customization	is	easy	and	straight-forward,	with	options	provided	that	allow	you	to	setup	your	site	to	perfectly	fit	your	desired	online	presence.	For	more	details,	visit	this	link	.	We	hope	you	will	find	the	Heroic	theme	useful.	Active	Installations:	700+	We	expanded
our	support	team	from	1	full-time	employee	to	6	part-time	employees,	so	we	were	looking	for	an	easy	way	to	share	our	knowledge	to	all	(new)	support	employees.	I've	tried	KnowAll	and	it	was	just	what	I	was	looking	for.	Easy	to	set	up,	all	employees	understand	it,	great	search,	their	support	team	responds	in	no	time	to	tickets	and	it	only	costs	$149.
For	us	it	is	a	no-brainer	to	keep	using	KnowAll.	Koen	Driessen	Co-founder	-	Scribbr	Heroic	is	een	responsive	en	veelzijdig	WordPress	thema.	Het	is	flexibel	en	geschikt	voor	blogs,	bedrijven	en	portfolio’s.	Aanpassingen	maken	is	makkelijk	en	eenvoudig,	met	de	aanwezige	opties	stel	je	je	site	perfect	in	voor	de	gewenste	online	aanwezigheid.	Voor	meer
details,	bezoek	.	We	hopen	dat	je	het	Quality	thema	bruikbaar	vindt.	Actieve	installaties:	700+	You	can’t	perform	that	action	at	this	time.	Get	help	for	our	Heroic	themes	&	plugins.	Search	our	articles	or	browse	by	category	below.	Heroic	is	a	responsive,	multi-purpose	WordPress	theme.	It’s	flexible	and	suitable	for	agencies,	blogs,	businesses,	finance,
accounting,	consulting,	corporations,	or	portfolios.	Customization	is	easy	and	straight-forward,	with	options	provided	that	allow	you	to	setup	your	site	to	perfectly	fit	your	desired	online	presence.	For	more	details,	visit	this	link	.	We	hope	you	will	find	the	Heroic	theme	useful.	Active	Installations:	700+	Personalize	KnowAll	to	match	your	company's
brand.	Effortlessly	change	the	logo,	colors	and	more	in	a	click.	No	coding	knowledge	required.	At	17,	I	built	my	first	forum	software	design	company,	serving	a	growing	user	base	before	selling	it	at	19.	This	ignited	my	passion	for	user-friendly	technology.	Leveraging	my	understanding	of	user	needs	in	the	WordPress	space,	I	founded	HeroThemes	14
years	ago.	Today,	HeroThemes	empowers	over	31,010	satisfied	customers	with	world-class	customer	support	tools	for	WordPress.	My	drive	to	simplify	complex	technology	fuels	every	product	we	create.	When	I'm	not	designing	the	future	of	WordPress	support	solutions,	I'm	out	exploring	hidden	gems	on	all	7	continents!	Heroic	ist	ein	responsives,
vielseitig	verwendbares	WordPress-Theme.	Es	ist	flexibel	und	eignet	sich	für	Agenturen,	Blogs,	Unternehmen	oder	Portfolios.	Es	läßt	sich	durch	seine	Optionen	leicht	und	schnell	anpassen,	sodass	du	deine	Website	perfekt	an	deine	Bedürfnisse	deiner	Online-Präsenz	anpassen	kannst.	Weitere	Details	findest	du	unter	.	Wir	hoffen,	das	Heroic	Theme	ist
hilfreich	für	dich.	Aktive	Installationen:	700+	Having	tried	a	few	free	plugins	and	third	party	systems	but	not	found	one	that	meets	my	needs.	The	Heroic	KB	plugin	was	much	better	than	anything	else	I	had	tried	and	really	easy	to	set	up.	It's	great	that	you	can	structure	the	articles	into	multiple	levels	of	sub-categories.	The	instant	search	is	excellent.	I
love	the	fact	that	the	knowledge	base	part	of	my	main	website	which	helps	with	SEO.	The	analytics	facility	is	great	and	provides	concrete	ideas	on	how	I	can	improve	the	knowledge	base	to	help	clients	and	reduce	the	number	of	support	tickets.	My	technical	director	found	it	easy	to	hook	into	the	templates	and	style	the	knowledge	base	to	look	really
professional.	Thanks	very	much!	Katie	Keith	Operations	Director	-	Barn2	Plugins	This	guide	walks	you	through	how	to	set	up	and	configure	the	Knowledge	Base	plugin.	To	install	Heroic	Knowledge	Base	you	will	require	a	self-hosted	WordPress	version	5.8	or	higher	installation.	You	can	install	the	plugin	in	a	number	of	ways:	From	Zip	File:	In	the
WordPress	admin	panel	navigate	to	Plugins	>	Add	New,	select	the	‘Upload’	and	browse	to	the	zipped	plugin	file,	and	hit	install	now.	FTP	Upload:	Using	your	FTP	program	upload	the	un-zipped	plugin	folder	into	the	/wp-content/plugins/	folder	of	your	WordPress	installation.	Once	the	plugin	has	been	installed,	you	need	to	activate	it.	Click	Activate	or
goto	Plugins	>	Installed	Plugins	and	activate	the	Heroic	Knowledge	Base.	Upon	plugin	activation,	you	will	automatically	be	sent	to	the	Heroic	Knowledge	Base	setup	assistant	screen,	which	guides	you	through	the	activation	and	setup	process.	Enter	your	license	key	(found	in	the	Licenses	tab	of	Your	HeroThemes	Account	or	purchase	email)	to	activate
support,	updates	and	smart	features	including	email	reports	and	help	assistant.	In	the	next	step,	you	will	see	a	message	confirming	the	site	has	been	successfully	activated.	If	you	are	unable	to	activate	the	site,	you	can	continue	with	setup	but	support,	automatic	updates	and	smart	features	may	not	work	correctly	until	this	is	done.	You	can
enter/update	your	license	at	anytime	from	the	Knowledge	Base	>	Settings	screen,	in	the	Licenses	&	Updates	tab.	You	can	manage	active	sites	from	Your	HeroThemes	Account	at	any	time.	Installing	Sample	Content	and	Required	Plugins	Heroic	KB	–	Plus	and	Pro	customers	–	ensure	you	download	and	install	the	Heroic	KB	–	Plus	/	Pro	Addons	plugin
from	the	Downloads	tab	of	Your	HeroThemes	Account	to	ensure	you	are	prompted	to	install	required	plugins.	The	setup	section	allows	you	to	install	demo	content,	including	a	numbers	of	articles,	categories	and	tags,	which	can	be	used	to	test	the	knowledge	base	layout	and	gives	a	great	example	of	how	the	knowledge	base	can	be	structured	and
tagged.	Note	there	is	no	demo	uninstall	button,	but	you	can	delete	and	edit	all	the	articles,	categories	and	tags	after	the	sample	has	been	installed.	To	install	the	sample	content,	select	Install	Sample	Content,	it	only	takes	a	few	moments	and	creates	and	configures	a	sample	knowledge	base	automatically.	From	the	setup	screen,	required	and	optional
plugins	can	be	installed.	The	available	options	may	vary	depending	on	the	tier	purchased.	Select	plugins	your	wish	to	install	and	click	Install	Selected	to	continue.	Once	setup,	an	Installation	Complete	message	will	be	displayed	with	a	list	of	the	basics	to	help	you	get	started	with	Heroic	Knowledge	Base	on	your	site.	In	order	to	receive	automatic
updates	and	premium	support,	be	sure	to	enter	your	license	key	during	setup	or	on	the	License	and	Updates	tab	from	the	setting	page.	This	will	help	keep	your	Knowledge		Base	running	smoothly	and	access	support	quickly	should	it	be	needed.	The	support	section	also	has	a	quick	link	to	this	documentation.	This	is	not	required	if	the	knowledge	base
is	packaged	with	your	theme.	The	Setup	Assistant	can	be	visited	again	at	any	time	from	the	Plugins	>	Install	Plugins	page	and	selecting	Setup	Assistant	Creating	and	Using	Knowledge	Base	Articles	There	will	now	be	a	new	Knowledge	Base	menu	in	the	WordPress	admin	panel.	From	here	you	can	manage	existing	articles,	create	new	articles	and
control	the	Knowledge	Base	categories	and	tags.	Articles	are	the	components	of	your	knowledge	base.	These	work	a	lot	like	any	other	posts,	but	have	there	own	archive,	categories	and	tags.	Select	Add	New	Article	to	create	a	new	Heroic	Knowledge	Base	Article.	From	this	page,	you	can	control	everything	about	your	article:	Title	–	The	title	of	the
article	Content	–	The	body	content	of	the	article	Options	–	Add	attachments	and	allow	voting	Format	–	The	format	of	article	(may	be	used	by	theme)	Categories	–	Custom	knowledge	base	categories	the	article	will	be	classified	under.	Tags	–	Custom	knowledge	base	tags	to	associate	with	the	article.	The	Knowledge	Base	adds	several	more	metaboxes,	to
add	features	to	your	articles.	Article	Options	Attachments	can	be	added	to	an	article	here.	Select	Add	or	Upload	File	to	select	attachments	to	add	to	the	article.	Note:	The	article	View	Count	is	calculated	from	page	visits	and	can	only	be	altered	in	the	database.	Disable	voting	on	the	individual	article.	Usefulness	is	determined	by	the	votes,	manually
setting	the	usefulness	in	this	box	can	cause	inconsistencies	to	develop	in	the	usefulness	calculation.	This	section	displays	the	votes	and	feedback	for	this	article.	You	can	search	through	comments	a	sort	by	ratings,	users	etc.	Delete	individual	votes	by	selecting	the	relevant	option	next	to	the	vote	Delete	all	votes	by	selecting	the	button	at	the	bottom	of
the	section.	The	usefulness	for	the	article	can	be	recalculated	from	the	votes	using	the	Recalculate	Usefulness	(rating)	button	at	the	bottom	of	the	section.	This	is	handy	when	the	usefulness	rating	falls	out	of	sync	with	the	votes.	Live	Search	Articles	The	knowledge	base	features	live	search	functionality,	users	can	search	the	knowledge	base	articles.
The	options	for	the	live	search	can	be	controlled	from	Heroic	KB	>	Settings	>	Search.	You	can	read	more	about	search	functionality	in	WordPress,	limitations	and	enhancements	in	our	guide	to	WordPress	search.	The	settings	menu	from	Heroic	KB	>	Settings	allows	you	to	control	various	options	for	the	whole	Knowledge	Base.		These	are	divided	into
various	sections	–	including	General	Settings,	Archive	Options,	Article	Options,	Search	Options,	which	can	be	seen	on	the	left	of	the	settings	panel.	These	settings	may	not	visible	or	configurable,	depending	on	the	features	your	active	theme	supports.	Alternatively,	they	may	be	set	as	theme	options	or	overridden	by	the	theme.	If	a	setting	does	not
appear,	it	means	the	current	theme	does	not	support	any	user	configurable	settings	for	this	item	The	general	settings	control	a	numbers	of	options	related	to	how	the	Knowledge	Base	is	displayed,	search	as	sort	order	and	the	number	of	articles	to	display	in	categories	and	tags.	This	options	page	controls	the	settings	for	the	knowledge	base	categories
and	tags.	Article	Options	The	article	options	page	controls	the	settings	for	the	individual	knowledge	base	articles,	such	as	meta	and	comments	options.		Note	comment	options	can	also	be	controlled	on	an	individual	basis	from	the	edit	article	screen	and	on	a	site	basis	from	WordPress’s	discussion	options.	The	search	options	page	controls	settings	for
options	related	to	the	Knowledge	Base	search	functionality.	From	v2.7.0	search	post	types	can	be	configured	with	a	new	filter.	You	can	read	more	about	the	WordPress	search	functionality	that	powers	the	knowledge	base	search,	including	how	to	extend	it	in	our	article	covering	Search	in	WordPress	here.	From	this	screen	you	can	set	the	slugs	for	the
Knowledge	Base	The	knowledge	base	allows	you	to	define	custom	slugs	for	Heroic	Knowledge	Base	articles,	categories	and	tags.	These	can	be	controlled	from	Knowledge	Base	>	Settings	>	Slugs.	On	updating	the	slugs,	you	may	need	to	‘flush’	your	permalinks	by	visiting	Settings	>	Permalinks,	this	forces	WordPress	to	update	the	relevant	slugs.	The
slug	for	the	knowledge	base	homepage	can	be	controlled	by	editing	that	page,	see	the	Home	&	General	tab	for	quick	link	to	the	knowledge	base	homepage	edit	screen.	Use	the	sidebar	settings	to	control	how	sidebars	appear	in	the	knowledge	base	section.	You	can	add	widgets	to	the	sidebars	from	Appearance	>	Widgets.	This	page	controls	the	overall
styles	for	the	knowledge	base.	If	you	wish	to	further	control	styles	beyond	these	available	options,	you	will	need	to	modify	your	theme.	Article	Feedback	This	section	allows	you	to	control	feedback,	which	you	can	use	to	gain	insight	from	readers	to	make	adjustments	and	improve	articles.	All	the	feedback	for	an	article	can	be	seen	on	the	Edit	Article
screen.	Provide	a	way	for	customers	to	quickly	access	your	support	system	with	the	transfers	functionality.	More	details	below.	To	enable	automatic	updates	and	access	premium	support,	enter	you	license	key	on	this	page.	Note	that	certain	themes	manage	the	licensing	and	updates	of	the	Knowledge	Base	plugin	and	will	not	require	entry	on	this	page.
The	Help	Assistant	(previously	called	Embed)	is	functionality	lets	you	add	your	knowledge	base	anywhere	on	the	current	WordPress	site	or	on	any	another	site	(the	external	site	doesn’t	need	to	be	WordPress),	the	knowledge	base	will	be	displayed	in	a	small	dock	in	the	bottom	right	hand	corner	of	the	site.	The	embed	settings	can	be	controlled	from
Knowledge	Base	>	Settings	>	Help	Assistant.	The	Help	Assistant	requires	that	you	have	activated	your	site.	Clicking	Show	Snippet	will	display	the	HTML	snippet	that	can	be	pasted	in	the	footer	of	the	target	site.	Note	that	you	will	need	to	ensure	your	X-Frame-Options	are	set	to	allow	the	help	assistant	to	work	on	other	domains,	if	the	help	assistant
does	appear.	Your	web	host	will	be	able	to	assist	with	this	configuration.	Note	the	embed	functionality	requires	articles	to	be	public,	any	hidden	or	restricted	content	will	not	be	displayed	correctly.	Email	Reports	are	weekly	digests	from	your	knowledge	base	sent	directly	to	email	addresses	you	specify.	The	reports	include	number	of	weekly	review
and	average	article	feedback	/	rating.	The	overall	top	viewed	and	top	rated	articles	is	also	listed.	To	received	email	reports,	your	site	needs	to	be	active.	The	settings	for	email	reports	are	contained	in	Knowledge	Base	>	Settings	>	Email	Reports.	Separate	multiple	recipients	for	the	report	with	a	comma.	Enable	HTML	reports	for	the	best	readability.
As	email	reports	is	reliant	on	the	ability	of	your	site	to	send	and	deliver-ability	of	email,	you	need	to	ensure	your	site	is	active.	Heroic	Knowledge	Base	comes	with	six	widgets	for	displaying	information	from	the	Knowledge	Base:	Articles	–	Knowledge	Base	Articles	Authors	–	Knowledge	Base	Authors	Categories	–	Knowledge	Base	Categories	Search	–
Search	the	Knowledge	Base	from	any	page	Table	of	Contents	–	Display	a	table	of	contents.	Only	works	on	knowledge	base	articles.	Exit	Point	–	Capture	visitors	that	leave	your	knowledge	base	to	an	internal/external	system	(see	section	below)	Widgets	can	be	activated	from	Appearance	>	Widgets	and	dragging	to	an	active	widget	area,	this	allows	you
to	display	key	information	from	the	Knowledge	Base	across	your	site.	There	are	widget	areas,	independent	of	the	theme,	controlled	by	the	knowledge	base:	Knowledge	Base	Sidebar	(Home)	–	for	the	knowledge	base	homepage	Knowledge	Base	Sidebar	(Categories	and	Tags)	–	displayed	in	knowledge	base	categories	and	tags	Knowledge	Base	Sidebar
(Article)	–	displayed	in	knowledge	base	articles	How	these	are	displayed	can	be	controlled	in	the	knowledge	base	sidebar	options,	detailed	in	the	section	above.	The	most	common	use	case	for	the	knowledge	base	is	a	portal	to	deflect	or	assist	support	tickets	or	sales	queries.	When	a	visitor	accesses	the	knowledge	base	but	then	goes	on	to	raise	a
support	ticket	or	complete	a	contact	form	(or	access	any	other	dedicated	page)	this	can	be	tracked	as	a	transfer.	It	works	for	both	internal	and	external	links.	You	just	have	to	ensure	the	transfer	widget	is	enabled.	From	Appearance	>	Widgets,	select	the	Knowledge	Base	Exit	Point	widget	and	drag	it	to	an	appropriate	widget	area.	A	dummy	page	and
widget	will	automatically	be	created	when	you	first	install	the	plugin.	You	can	set	other	options	such	as	the	title,	text	and	button	text.	Set	the	transfer	page	URL	The	transfer	page	can	be	set	from	the	widget’s	link	URL	or	from	Settings>Transfer	Options	>	Default	Transfer	URL.	This	should	be	the	page	you	want	to	direct	visitors	to	if	they	are	unable	to
find	an	answer	to	their	query	in	the	knowledge	base.	When	a	user	clicks	on	the	link	in	this	widget,	the	source	knowledge	base	location	is	recorded	and	can	be	analysed	with	the	analytics	module	(see	below).	The	analytics	module	is	available	only	in	Heroic	Knowledge	Base	(standalone)	and	KnowAll	packaged	theme,	for	the	Plus	and	Pro	tiers.	The
analytics	dashboard	provides	a	way	of	analysing	your	knowledge	base,	helping	you	write	better	articles	and	fix	issues	where	visitors	are	unable	to	get	answers	to	their	support	queries.	The	analytics	data	is	populated	by	usage,	so	over	time	you	can	assess	views,	feedback	and	search	behaviour.	The	first	tab	is	the	dashboard,	from	where	you	can	set	the
date	range	in	the	top	right	corner.	This	sets	the	period	for	analysis	and	will	automatically	be	set	to	a	month	on	login	or	after	inactivity	on	the	analytics	pages.	From	the	dashboard	you	get	certain	key	metrics	for	your	knowledge	base	–	views,	key	statistics	(total	articles,	articles	published	and	total	views),	article	feedback	and	search	effectiveness.	The
knowledge	base	views	is	displayed	as	a	graph,	showing	the	total	views	on	the	knowledge	base	per	month.	This	is	drawn	from	visits	on	articles,	categories	and	the	knowledge	base	archive.	Next,	the	Knowledge	Base	statistics	give	an	insight	into	the	size	and	popularity	of	your	knowledge	base	in	the	date	range,	displaying	the	overall	total	articles	at	the
end	of	the	period,	the	articles	published	in	the	period	and	the	total	article	views	in	the	period.	The	article	feedback	shows	the	total	helpful	and	unhelpful	votes,	giving	an	overall	success	metric	for	your	articles.	The	search	effectiveness	displays	the	total	searches	of	the	knowledge	base	in	the	period,	and	the	number	of	those	that	failed-	resulted	in	no
results.	This	allows	you	to	assess	how	well	visitors	are	finding	answers	to	their	queries.	The	feedback	tab	provides	further	insight	into	the	visitor	feedback	on	the	knowledge	base	articles.	Upvotes	and	downvotes	(helpful/unhelpful)	cast	during	the	period	are	displayed	on	a	bar	chart.	Where	visitors	have	then	left	feedback,	the	last	30	responses	in	the
period	are	displayed	below	as	cards.	You	can	filter	the	cards	by	helpful	or	unhelpful	votes	and	further	interrogate	the	comments.	Where	comments	are	larger	than	the	card,	hovering	over	the	comment	will	reveal	the	full	text.	The	search	tab	displays	key	knowledge	base	search	information.	The	search	overview	displays	on	a	pie	chart	the	split	between
searches	that	resulted	in	knowledge	base	articles	being	returned	and	searches	where	there	were	no	results.	Searches	by	month	in	the	period	are	displayed	in	a	graph,	allowing	you	to	assess	search	volume	trends	over	time.	Searches	that	results	in	no	results	are	displayed	in	the	null	searches,	sorted	by	the	times	no	results	are	returned.	If	there	are
numerous	null	searches	with	the	same	words,	it	suggests	visitors	are	unable	to	find	the	articles	they	are	looking	for.	The	popular	searches	panel	shows	the	most	popular	search	topics	visitors	are	looking	for	in	your	knowledge	base.	This	information	could	be	used	to	identify	articles	the	should	be	improved	or	expanded	to	ensure	they	are	catering	for
your	audience.	Where	you	link	to	another	resource	(such	as	ticketing	system,	sales	page	or	contact	form)	from	your	Knowledge	Base,	using	the	transfers	functionality,	a	record	is	made	of	where	this	occurs	to	help	you	further	identify	articles	or	sections	that	need	improvement.	By	analysing	where	your	visitors	are	leaving	to	raise	a	ticket,	you	get	a
metric	of	the	transfer	percentage	and	another	indicator,	in	addition	to	visitor	feedback.	Transfers	can	be	added	to	three	knowledge	base	objects	–	the	archive,	categories	and	articles.	The	transfer	split	pie	chart	gives	the	overall	split	of	where	transfers	are	occurring.	Category	Transfers	shows	transfers	made	from	categories,	this	could	be	when	a
visitor	has	navigated	to	a	category	but	is	unable	to	find	an	article	that	matches	what	they	are	looking	for.	Article	Transfers	displays	visitors	exiting	from	an	article,	to	help	identify	indivdual	articles	that	need	improvement.	You	can	link	to	any	of	the	knowledge	base	articles	as	with	any	other	post.	To	add	the	knowledge	base	to	a	menu,	go	to	Appearance
>	Menus	and	add	the	page	set	as	your	knowledge	base	homepage.	Using	the	Knowledge	Base	as	the	homepage	To	use	the	Knowledge	Base	as	the	homepage,	set	Front	page	to	your	knowledge	base	homepage	in	Settings	>	Reading.	Visitors	to	the	knowledge	base	can	vote	on	articles.	When	a	user	votes	up	or	down,	they	can	add	feedback	to	an	article,
which	can	be	viewed	from	the	‘edit	article’	screen.	Top	articles	and	contributors	are	assigned	badges,	depending	on	theme	support.	Using	Articles	in	Posts	or	Pages	The	knowledge	base	articles,	categories	and	tags	are	self-contained,	and	you	can	link	them	from	any	other	page	or	post.	The	articles	archive	page	links	to	all	the	other	articles	and
categories		eg	www.example.com/articles.	You	can	use	your	theme’s	style.css	(or	preferable	child	theme)	to	control	most	aspects	of	the	styling	of	the	Knowledge	Base.	With	the	Heroic	Knowledge	Base,	you	can	create,	edit	and	control	custom	categories	for	your	knowledge	base	articles.	Knowledge	base	categories	can	be	created	in	two	ways:	1.	From
Knowledge	Base	>	Article	Categories.	2.	From	an	article	add/edit	page,	under	the	Knowledge	Base	Category	In	supporting	themes,	category	images	and	colours	can	be	controlled	from	the	Edit	Knowledge	Base	Category	page.	These	options	will	appear	if	available.	Controlling	the	Article	Order	Article	order	in	the	Knowledge	Base	Categories	can	be	set
by	heading	over	to	your	WordPress	Dashboard	>	Heroic	KB	>	Settings	>	General	page.	Scroll	down	to	the	Categories	&	Tags	section,	where	the	Article	order	can	be	managed	using	the	Sort	By	and	Sort	Order	options.	Article	order	can	also	be	manually	set	when	the	Sort	By	in	General	Settings	is	set	to	Custom.	The	article	order	can	then	be	set	from
the	Knowledge	Base	>	Article	Ordering	menu.	Simply	select	the	category	you	want	to	re-order	articles.	You	can	then	drag	and	drop	the	articles	in	that	category	to	re-order.	Click	Save	Order	at	the	bottom	of	the	page	to	save	the	article	order.	The	knowledge	base	category	order	can	be	controlled	from	the	Knowledge	Base	>	Article	Category
Ordering	page.	Drag	and	drop	categories	to	re-order	and	change	the	order	they	are	displayed	on	your	site.	Click	Save	Order	at	the	bottom	of	the	page	to	save	the	category	order.	The	parent	category	and	nesting	options	can	be	controlled	from	the	Edit	Category	page	in	Knowledge	Base	>	Article	Categories.	For	customers	with	an	active	site,	you	can
reach	the	support	team	at	HeroThemes	Support.	How	do	I	reset	article	votes?	Votes	for	an	individual	article	can	be	reset	by	editing	an	article,	and	checking	the	“Delete	All	Votes”	box,	found	in	the	“Votes	and	Feedback”	section.	Then	simply	update	the	article	and	all	votes	will	then	be	removed.	How	do	I	password	protect	articles?	Individual	articles
can	be	password	protected	in	the	same	way	as	other	WordPress	posts	and	pages.	See	Using	Password	Protection	on	the	WordPress	Codex	for	more	details.	Please	see	our	separate	Integrating	Heroic	Knowledge	Base	with	your	theme	guide	for	detailed	instructions	on	integrating	the	Heroic	Knowledge	Base	with	themes	(standalone	Heroic	Knowledge
Base	purchase	only)	I	get	a	404	error	when	accessing	Knowledge	Base	pages?	The	most	common	cause	of	this	is	the	permalinks	have	not	been	flushed.	To	force	this,	simply	visit	the	Permalinks	settings	page	from	Settings	>	Permalinks	and	hit	save	in	your	WordPress	dashboard	and	then	try	again.	It	is	recommended	for	most	themes,	the	Permalinks
are	not	set	to	default.	For	more	details	see	this	article	for	guidance	on	using	Pretty	Permalinks.


